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Introduction
Control of the spare parts inventory is an important feature of maintenance management.    This 
ensures that the spare parts are always available when needed.

The information commonly required for spare parts inventory management and control is:
n The number of the spare part - this facilitates ordering of the spare parts and makes it 

unnecessary to retrieve it from manuals each time an order is made.
n The name or description of the spare part - facilitates identification of the part and what it is for.
n A listing of the equipment that uses a given spare part - provides an overview of the 

requirements.
n A listing of spare parts available for a given item of equipment - to tell whether the part is in stock

or not.
n The number of items of a spare part in stock.
n The reorder quantity - a constant that tells you at which inventory level you must order more 

spare parts.
n The quantity to order at the reorder level - see below for further details on both these terms.
The reorder level and the quantity to order can be established in various ways.    In a "vital few" 
cases, where the spare part is very expensive or otherwise very important, they can be calculated 
from complex equations that involve statistical data.    In "trivial many" cases, it is sufficient to define 
them, based on past experience of adequate supply and on rules of thumb.    For the methodology to 
be used, reference is made to literature on inventory control.

The objective of spare parts inventory management is to have spare parts available in sufficient 
supply to avoid unnecessary downtime in the production.        At the same time the level of inventory 
is kept at its economic optimum.    These objectives contribute actively to the economic performance 
of the company.



What SPARES is
SPARES is a companion program to MPM for control and management of the spare parts inventory.   
It thus integrates the spare parts inventory management into the maintenance management 
supported by MPM.

SPARES cannot be run independently from MPM, since the two programs share some data.    It has 
been considered prudent to have them as two separate, dependent programs, rather than joining 
them into one program.    The main reason for this is that data could inadvertently be erased if they 
were one.



How SPARES works
SPARES uses the data from MPM on inventory areas and equipment inventory.    It combines this 
data with information on the spare parts inventory to form its complete database.

The database is used to provide the following:
n An inventory 'card' for each spare part with information on its inventory code, its description, for 

what equipment it is used, its unit price, the number of items in stock, the reorder level and the 
quantity to order.

n A listing on screen of all equipment of a given inventory area, showing the name of the 
equipment, its inventory code, its year of purchase, its price, annual depreciation and its book 
value today.

n Several means for easy access to the inventory cards and the information given in them.
n A complete listing of all spare parts in the inventory, showing their name, inventory code, spare 

part number, number of items in stock and the reorder level.
n A listing of all spare parts for a given item of equipment, with the same data as above.
n A listing of all equipment that uses a given spare part.
n All the above lists can be displayed on screen and the the two mentioned last can also be printed

or saved to a file.
The reorder level and the quantity to order are not established by the program, but need to be 
entered by the user.    The reason for this is that there is no one method to be used for this in any 
inventory.

The program ensures that the necessary data needed is created for an adequate and cost efficient 
inventory of spare parts.



System requirements

Hardware requirements
n Personal computer using 286 type or higher microprocessor, with a hard disk drive (386 type or 

higher recommended).
n 2 MB of memory.
n EGA, VGA, Super-VGA, XGA, 8514/A or compatible video card with corresponding monitor.
n Mouse.

Software requirements
n Microsoft DOS version 3.1 or higher.
n Microsoft Windows version 3.0 or higher.
n MPM for Windows.



Help on Help

Three routes to Help
You have access to the on-screen Help program in three ways:    As a specific menu item in the Help 
Menu, by pressing the [F1] key, or from the Help button in the dialog boxes.

Help as a menu item
The Help menu has two options for calling Help.    First, 'Help on SPARES', which gives you the 
Contents screen of Help.    From this you can access all the other screens and read them as an on-
screen manual for SPARES.    Second, there is the 'Help on Help' option, which calls this screen.

Help from F1
Help, obtainable by pressing the [F1] key is context-sensitive, that is, the Help screen displayed 
depends on what menu option was highligthed before [F1] was pressed.

If no menu item has been highlighted, Help displays its Contents screen.    Please note that Help 
cannot be accessed by pressing [F1] when a dialog box is displayed.

NOTE:    Sometimes, if you press [F1] several times, the menu ceases to repond to mouse clicks.    
The reason is that the command has not been given back to the menu.      To return the command to 
the menu in such cases, press the [Esc] key once.

Help for dialog boxes
The only way to acces Help when a dialog box is displayed is by clicking on the Help button of the 
box.    This displays the Help listing for dialog boxes.



Getting started

Introduction
Since SPARES is a dependent companion program of MPM,    certain features of most Windows 
programs are absent to avoid loss of data.    These features, like 'New file' of 'Save As...' are available
in MPM, but not in SPARES.

Closing the logo window
Starting a new inventory
New spare parts inventory data
Saving your work



Closing the logo window
The logo window is displayed continuously on the screen until you point at it with the mouse and click
the right mouse button.    An alternative is to press any key, except the [Alt] key.



Starting a new inventory
SPARES assumes that a database has already been created with MPM for the equipment inventory.  
The spare parts inventory created will then latch on to that database.

Therefore, you must start by loading the MPM database, using the 'Open...' option in the File Menu.   
This also activates the other menu choices which are greyed = inactive until the MPM database has 
been loaded.

The next step is to select 'New'    from the Spares Menu.    This displays an empty spare part 
inventory card to be completed.    By    entering the data requested for each spare part, you create the
database for your spare parts inventory.



New spare parts inventory data
When the spare parts inventory card is displayed, the cursor is already at the first input window .    
Use the [TAB] key to move from one input window to the next.    Press [Enter] only when you have 
finished entering data into the card.    The inputs are:
n Inventory code - This is a code you assign to the spare part as part of you inventory system.    

The program uses that code for its searches and accordingly, it must be unique.    If you enter an 
already existing code, the program will alert you and refuse to accept the input.

n Spare part number - this is a code provided by the manufacturer and defines the equipment 
when you order it,

n Price - the unit price of the spare part.    Although this will vary over time, it is still one of the 
parameters to consider when defining the reorder level and the quantity to order.

n Item - this can just be the name of the spare part, but it may also in some cases include a very 
brief description, if necessary.

n Uses - the items of equipment in which the spare part is used.    The input here is very important 
for data retrieval and searches.    Enter the equipment inventory code used in MPM for each of 
the items of equipment.    You can use spaces, commas, or whatever separator you wish 
between the different codes, for instance: F198,F246,M104.

n In stock - the number of spare parts of this type available in the inventory.
n Reorder level - the inventory level at which a new order must be placed.
n Quantity - the quantity to order when the reorder level is reached in the inventory.
For a very brief discussion on reorder level and quantity to order, see
Introduction



Saving your work
To save your work, select 'Save' from the File Menu.    This will automatically save the spare parts 
inventory data in a file with the same name as the MPM inventory data, but with the extension '*.sps'. 
Thus, if the equipment inventory data is in files beginning with    "MYFILE.MP1", the spare parts 
inventory data will be saved in "MYFILE.SPS".



Procedures

Introduction
The initial procedures and those used for entering new data and saving data have already been 
described.
Getting started

The remaining procedures are defined in the following:
Loading data
Retrieving a spare part card
Editing    and updating data
Deleting data cards
Listings of data on screen
Printing lists
Filing lists



Loading data
To load data for the equipment and spare parts inventories, click on the 'Open...' option in the File 
Menu.    Then select the appropriate file from the listing shown.    This will load both the equipment 
and the spare parts data, unless the latter has not yet been created.

It will also activate the other menu options which until now have been grayed = inactive.



Retrieving a spare part card

Introduction
There are several options for retrieving a spare part inventory card.    The card can thus be retrieved 
based on whatever information    is available on it.    These methods of retrieval can be divided into 
two groups, indirect and direct.    It is also possible to use combinations of the two in some cases.

Indirect retrieval
The principle of indirect retrieval is that you first search for the exact name of the spare part or its 
inventory code.    With that information, you select the View/Edit option in the Spares Menu, and do 
the search based on the name of the item or the spare part inventory code.    The way of finding the 
name of the item or its code depends on what information you have about the spare.

Nevertheless, the most common approach is probably that you know more or less the name of the 
spare part.    In that case,
n Click on 'All spares' in the Spares Menu.    This will give you a complete listing of the spares.    

Find the spare in the list and note its exact name or code.
n Make a search for the card, by name or code, by selecting the View/Edit option in the Spares 

Menu.

Direct methods
The direct methods are usually preferred as faster and simpler, whenever they can be applied.    
Again, the approach depends on what you know about the spare part.    Of course, if you know its 
exact name or its code, you could use directly the second step in the indirect method above.    
However, in most cases your memory of the inventory may not be sufficently accurate to use such an
approach.
If you know what equipment the spare part is used for, you can use the following procedure:
n Click on the 'Find spare' option in the Equipment Menu.
n Select the area in which the equipment is located (see your MPM manual for definition of 

inventory areas).
n From the list displayed, select the equipment of your choice.
n Select the spare part from the list.    This gives you its inventory card.



Editing and updating data
Each time a spare part is retrieved from the inventory, the number in stock of that part needs to be 
updated in the spare parts inventory card.    There may also be other items that need editing or 
updating.    However, please note that you cannot update the spare parts inventory code, except by 
deleting the card and completing a new one.

To update/edit the information in a card, once it is retrieved, proceed as follows:
n Move the cursor to the input window for which you want to make the change, using the [TAB]    

key or by clicking the left button of the mouse on that window.
n Change the input as required.
n Repeat the procedure for the other input windows of the card as required.
n Click on the 'OK' button or press the [Enter] key when you have finished.



Deleting data cards
To delete a data card, use the following procedure:
n Retrieve the spare part inventory card. Please note that in this case you must retrive the card 

using the ''View/Edit' option in the Spare Menu.
n Click on the delete button on the card.    A warning will be displayed.    Click on 'Yes' and the card 

is removed from the database.



Listings of data on screen

Equipment in an inventory area
n Click on the 'All equipment' option in the Equipment Menu.
n Select the inventory area for which you want the listing.
n This displays the list of all equipment in that inventory area, with information on inventory code, 

year of purchase, price, annual depreciation and present value.

Spare parts used by a given equipment item
n Click on 'List spares' in the Equipment Menu.
n Click on 'Display'.
n Select the inventory area where the equipment of your choice is.
n Select the equipment from the listing displayed.
n This displays a listing of all inventoried spare parts used by the item of equipment, with data on 

inventory code, spare part number, number of items in stock and the reorder level.

Equipment using a given spare part
n Click on 'List equipment' in the Spares Menu.
n Select the spare part for which you want the listing.
n This displays a list of equipment which use that spare part, with information on inventory code, 

year of purchase, price, depreciation and present value.

Complete listing of spare parts
n Click on 'All spares' in the Spares Menu.
n Click on 'Display'.
n This gives a complete listing of all spare parts in the inventory, with information on inventory 

code, spare part number, number of items in stock and the reorder level.

Clearing the lists on screen
The lists are all shown on screen in two windows; one with the headings, and the other for scrolling 
the data in the list.    When you have finished viewing the lists, point the mouse at one of the windows
at a time and click the right mouse button    Failure to clear the lists will cause interference with 
display of subsequent listings.



Printing lists
Two listings can be printed:
n The list of spares used by a given item of equipment (Click on 'List spares' in the Equipment 

Menu).
n A listing of all spare parts in the inventory    (Click on 'All spares' in the Spares Menu).

To print these list, continue as follows:
n Click on the 'Print' option.
n Make sure your printer is switched on, connected to the right printer port and on line.
n Change the printer selection and setup, if necessary, otherwise click on 'OK'.
n Wait for the printer to finish printing.



Filing lists
Two lists can be saved to a file:
n A list of spare parts used by a give item of equipment (Click on 'List spares' in the Equipment 

Menu).
n A complete listing of all spare parts (Click on 'All spares' `in the Spares Menu).

To save these lists to a file, continue as follows:
n Click on 'File'.
n Select the directory to which you want to file it.
n Enter a name for the file.    The default extension is ,*.spl', but you can choose an extension of 

your own.
n Click on 'OK' or press [Enter] and the file is saved.



Menu commands
There are four options in the SPARES menu bar:
n File - with file related options and 'Exit'.
n Equipment - with options that have emphasis on data from the equipment inventory and their 

relationsship with the spare parts inventory.
n Spares - with option that have emphasis on the spare parts inventory data.
n Help - mainly for accessing Help.
Further details of the menu commands are given in:
File menu
Equipment Menu
Spares Menu
Help Menu



File menu
There are five options in the File Menu:
n Clear data - This clears all data in the memory.    Use this option only if you have been working 

with one set of data and then want to load another set to replace it.    The option is essentially a 
safeguard against 'cross-breeding' of two data sets.

n Open... - Opens and loads equipment and spare parts data files in one go.
n Save - saves the spare parts iventory data.    There is no need to save the equipment inventory 

data, since it can only be modified by the MPM program.
n Printer setup - To select printer and modify its setup, if needed.
n Exit - to exit from the program.    If there is a possibility that the data have been changed, the 

program will ask if you want to save.



Equipment menu
There are three main options in the Equipment Menu:
n List spares - to list the spare parts used by a given item of equipment.    The list can be displayed

on screen, pronted or saved to a file.
n Find spares - to retrieve a spare parts inventory card, if you know which equipment the spare 

part is used for.
n All equipment - to list all equipment in an inventory area.



Spares menu
There are four main options in the Spares Menu:
n New - to display a new spare part inventory card.
n Select/Edit - to retrieve an existing spare part inventory card.    The search can be made 

according to the name of the item or its inventory code.
n All spares - to list all spare parts in the inventory.    This list can be shown on screen,    printed or 

saved to a file
n List equipment - to list all equipment that uses a given spare part.



Help menu
There are three options in the Help Menu:
n Help on SPARES - to access Help.
n Help on Help - to show how help can be accessed in various ways.
n About... - with some information on SPARES.



Dialog boxes
The program uses dialog boxes to communicate with the user.    Most of them are straightforward 
and only convey a message or a warning.    Two of them, however, are more important and one 
extremely important:
n Inventory area select box - expects a selection of inventory area for equipment.    Click on the 

item you want to select and then on 'OK'.
n Selection box - is used for selection from a list of equipment or spare parts.    Click on the item 

you want to select and then on 'OK'.
The most important one is, of course the box that represents the spare parts inventory card:
New spare parts inventory data
Deleting data cards
Editing and updating data



Copyright
Copyright © 1993,    Börje Kyrklund.
All rights reserved.



Registration
Since SPARES is a companion program to MPM, no separate registration is needed.    See the 
corresponding item in MPM for information on registration.



Technical support
See the corresponding item in MPM for information on technical support.



MPM
Maintenance Planning and Management






